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1 What’s new? 

Version Date Modification 

V4.10 February 
2020 

Beware: add-ons Simconnect like DoDOSIM have to be redeployed in V4.10 
version due to a SimConnect upgrade 
 
New 
- Add P3D V4.5 support 
- FMS PAGE supports PROSIM A320 
- Add a feature to find Radio Com frequencies 
- New FSUIPC dll  
- COMPUTER page is accessible without Sim Connection allowing to stop the entire 
cockpit when Prepar3D is stopped 
 
Fix 
- you can't set FREEZE and EXIT features to be open in a dedicated window 
(SETTINGS> MENU PAGE) 
- If you kill P3D/FSX, you could have a FSUIPC ERROR 
-  During Soft Launcher validation test, an error "Hello" appeared 

V4.09 August 
2018 

New 
- POSITION PAGE 
 - Change the speed selection look 
 - Add ILS interception  
- MAP PAGE 
 - PLOT is reset after an aircraft Move 
 - Add BEARING/DISTANCE of Point on the map 
- APPROACH GRAPH REPORT  
 - PDF creation shows a progress bar during build 
- After a MOVE, change the window “UNFREZZE” 
- PROSIM: change the trim calculation 
Fix 
- APPROACH GRAPH REPORT  
 - FIX: Error in the report name 

V4.08 May 2018 New 
 - New refuel engine 
 - RFID badge integration 
 - aircraft page shows now the current available engines only 
  
Fix 
 - Temperature could be stuck to 40°C 
 - On EHAM TAMPA and KAIH add-on sceneries (bad runways) – please 
rebuild your database 
 - Approach graph supports negative ground altitude 
 - If mode FORCE FULLSCREEN/ON TOP, when clicking on METAR, you don't 
see the window and it stuck the interface 
 - When you created a new situation, if the name contained forbidden 
characters (as "/", "*"), P3D didn't record this situation 

V4.07 February 
2018 

New 
- Add your own elements on the map (vectors, texts…)  
- PROSIM 737 V2 support 
- Google Earth Pro support  

Fix 



- Google earth tracking issue 
- Reports are now stored in OUTPUT directory 
- Virtual keyboard is not visible by default 
- REPORT: spoilers appear only for JET aircraft 

V4.06 December 
2017 

New 
- Several WideClient connections shared on different FS Instructor instances 

(for PRO version only) on the same Windows session. 
Fix 

- Generated files are no longer stored in My Documents. Now they are 
created in your FS Instructor/OUPUT directory 

- Your own failures.txt has to be stored in the CUSTOM directory 

V4.05 October 
2017 

New 
- Add a virtual keyboard for tablet users 
- DME navaids appear on the map 

Fix 
- POSITION > Runway buttons size fixed 
- SELECT A PAGE: this menu appears only when we are connected 
- Database generation: better add-ons management 

V4.04 June 2017 New 
- Prepar3D V4.x support 
- Soft launcher V4 implementation 
- Password protection to open the settings dialog  
- Dodosim PRO support – dedicated Add-on 
- New Prosim implementation (B737/A320) 
- Full adaptation for light, jet or helicopter 
- Open Architecture with our SDK: Developers can create FS Instructor add-

ons (ask us our SDK). 

2 Install and start 

2.1 Requirements 

HARDWARE 

- CPU: At least Intel Core i5 1,40 Ghz (poor performance expected in the MAP page) 

 

SYSTEM 

- PC or Tablet PC (running Windows OS) 

- Windows Vista to Win 10 - 32 or 64 bits 

Screen resolution higher than 800 x 600 

- .NET Framework 4.5 (https://www.microsoft.com/fr-fr/download/details.aspx?id=49981) 

- Peter Dowson’s FSUIPC registered version 4.9 and 5.x. 

For a remote use: 

o WideFS (6.9 and higher) http://www.schiratti.com/dowson.html set and tested 

o A good network (avoid Wi-Fi) - 100MB or Higher recommended) 

 

SIMULATORS 

https://www.microsoft.com/fr-fr/download/details.aspx?id=49981
http://www.schiratti.com/dowson.html
http://www.schiratti.com/dowson.html


- Lockheed Martin Prepa3D@ V1.x to V4.x 

- Microsoft Flight Simulator FSX™, ESP™, STEAM edition (FSX se) 
 

Add-On supported 
o PROSIM737 and PROSIMA320 

o Ifly thru iFly to FSUIPC V2.x  module. 
o Project Magenta 

o Jeehell A320 (as standard) 

o AST 320 (as standard) 

o All standard aircraft 
o Dodosim (dedicated plugin for the DODOSIM PRO users) 

 
➔ X-PLANE is not supported, even though XUIPC gateway.  
 

2.2 Support 
Support is exclusively done via email: contact@fsinstructor.com 

We don’t support issues between WideFS and FSUIPC. Try to read chapter 2.3 (To check if the 

connection between WideFS and FSUIPC works) or contact the program’s author. 

 

2.3 To check if the connection between WideFS and FSUIPC works 
If you launch FS Instructor on a remote computer, you have to use WideFS. It manages a 

communication with FSUIPC. It’s a gateway between the instructor station and the remote Flight 

Simulator 

You have to use the last FSUIPC AND WIDEFS release. (http://www.schiratti.com/dowson.html). 

Read the WideFS handbook to install, set WideServer.ini file (On the Flight Simulator side) and 

WideClient.ini (On the FS Instructor side). 

To check that it works, you have to read on the Flight Simulator window title « one client 

connected ». 

2.4 Installation 
- Install .NET Framework 4.5:  

- Run FS Instructor V4.exe as an administrator  

 

Note: At the first launch, a « FS_Instructor » folder is created in “my Documents”. It stores 

necessary files. If this folder is deleted, it will be automatically created again but you will lose 

your license file.  

 

- In certain cases, the application 

could appear outside of your screen.  

To reinit his position you will find an 

icon on the right of the task  

http://library.flight1.net/?p=4311
mailto:contact@fsinstructor.com
http://www.schiratti.com/dowson.html


bar. This icon changes according to the launched application. 

  

2.5 QUICK  START 

• Install .NET 4.5 

• Check that Wideclient is well configured and communicates with Flight Simulator 

• Start FS instructor as an administrator 

2.5.1 Aircraft type selection 

During the first execution, a screen asks you which kind of aircraft you will use. Just click on one type.

 

 JET LIGHT HELICOPTER 

Circuit Pattern IFR VFR VFR 

Type of Gate Medium and large Small - 

Surface to land Hard only Hard & grass Helipad, Grass & Hard 

Background 

   
Menu Pushback page 

FMS page 
Pushback = deactivated 
FMS = deactivated 

Pushback = deactivated 
FMS = deactivated 

AIRCRAFT PAGE Show FLAPS 
Show SPOILERS 

Show FLAPS 
- 

- 
- 

 

You kind change this configuration later from the Settings Windows> AIRCRAFT 

  



2.6 Update FS Instructor 
To update your current release, use the “Check Update Online” feature (menu > File). It requires to 

be connected on Internet. 

  

If a new version is available, you can use the “UPDATE” button. It downloads the new release. 

 

If the download is successful a window appears with the procedure to install the new release.

 

Note, when you update FS Instructor, it keeps your settings. 

 

3 SETTINGS 
It is important to tune FS Instructor at the first start. Open the configuration 

windows from MENU > File > SETTING 

 

 



3.1 General settings 

 

Global Font 
resize 

It adapts the font size of the application 

Screen mode Switch from FULL SCREEN or WINDOWED 

Default page at 
start 

Choose if one page has to be opened when you start FS instructor 

Menu number of 
lines 

How the MENU buttons are distributed 

Error Mode log Use it only if you have troubles and you need to send traces to our support 

DEBUG It opens a new window to follow log traces 

Use a virtual 
Keyboard 

If you have a tablet, this open opens a virtual keyboard when you click in a field 

 
Update weather 
when you open 

Weather 
module 

If you are using an external weather engine, you have to deactivate the 
automatic FS Instructor weather. 

Traffic update 
includes General 

aviation 

Traffic feature impacts Airlines density. 
By default, general aviation is OFF (0%). 
If you want to keep general aviation, you have to enable this feature 

 



 

3.2 Menu Settings 

 

3.3 Aircraft settings 

 

 

3.4 DATABASE SETTINGS 

 

3.4.1 Update the airport/runway/parking/taxiway database 

Runways, Airports, Taxiways, parking are extracted from your own sceneries. 

Build your database according your installed sceneries. Do it each time you install or update a 

scenery. This step is needed to have an up-to-date moving map and Position modules. 



1 – Browse to your sceneries directory. You can use a network/remote directory. 

 

 

GENERATE TAXIWAYS - The taxiway paths create a big database file. It takes time to load and could 

decrease performance. 

Uncheck this feature, rebuild the database. 

 

2 - Build the database. It takes a while to scan all your directories and to generate the new database. 

If you have errors during database generation: 

- Check you have enough rights on the files/directories (at least read rights) 

- If data are stored on a remote computer, try to copy Scenery path on the local machine. 

This action doesn’t update the navaids (VOR/ADF…). This kind of data is extracted from AIRAC. 

3.4.2 Create the airports/runways database from your FSX/P3D installation 

If you don’t have a network access to your P3D or if sceneries are shared on several drives, you can’t 

use the FS Instructor database generator. 

You have to use “FSI BUILD DATABASE STANDALONE version” 

http://www.fsinstructor.com/download/FS_Instructor_4/FSI_Build_Database_STANDALONE.zip 

This software is deployed in your FSX/P3D directory and can read the scenery.cfg file and manage 

specific path for add-ons. 

It creates an extraction file to move in your FS Instructor path. Check the embedded manual. 

 

http://www.fsinstructor.com/download/FS_Instructor_4/FSI_Build_Database_STANDALONE.zip


 

 

3.4.3 Update the Navigraph database 

3.4.4 Check the installed database 

FS Instructor loads navaids (VOR / NDB), Waypoints and Procedures (SID / STAR / APP) from a 

Navigraph database. 

You can buy the latest Navigraph packages on www.navigraph.com 

After the Navigraph database installation check that you have a file “navaid.db” in <Your 

document>\FS_Instructor directory (see the procedure below) 

To be sure that FS Instructor uses this database, open FS Instructor > Setting > DATABASE 

 
You can see Navigraph information. 

http://www.navigraph.com/


If FS Instructor can’t find the database, you have this message.

 

3.4.5 Install a Navigraph AIRAC database 

Buy the latest Navigraph packages on www.navigraph.com. 

Install the exe file 

 

http://www.navigraph.com/


Select “My documents” directory

 

 

Restart FS Instructor to load this new database. 

Check that FS Instructor found the database (MENU > SETINGS > DATABASE) 

  



3.5 Add-Ons settings 

 

3.5.1 Set editor Product (Prosim, Project Magenta) 

By declaring a specific product, you take the advantage of specific features: 

- Dedicated failures system 

- Dedicated FMS support 

3.5.2 Add-Ons 

FS Instructor is an open architecture. It means you can add new plugins and new features. 

.NET Developers can ask an SDK to create their own FS Instructor add-ons. 

The available add-on list can be found in our shop: http://fsinstructor.com/ 

 

3.6 Units / Fuel Settings 

 

http://fsinstructor.com/


 

3.7 SECURE settings 

 

Feature Description 

Force FS Instr. Always 
on top 

FS Instructor can’t be on the background. It prevents users to open 
another windows program. 

Password protection This password protects the access of the Settings window and prevent to 
EXIT without Authorization. 
 
The password is encoding and linked to the current user. You can’t unlock 
the feature by using this password from another Windows account. 
 
If a user try to access to a secured feature, it will ask the password 

 
Access with an ID card [Hardware and specific plugin required to work] Contact us 

to manage cockpit access with ID badge 

 

 



3.8 Map settings 
Each map element can be customized 

 

For example - to have a pink rose with a taller font, click on rose “QUERTY” button  

 

  



It gives 

 

3.8.1 Improve map performance 

When you try to display too much element, the map could stop to move. Decrease the number of 

display elements or limit the performance (slide): 

A - Slide Perf Very high/very poor 

  

This option has impacts on: 

- Screen refresh time  

- Data loading  

- Navaids range 

B – Limit details for the countries shape

 

 

 

 



Low details Better details 

  

3.8.2 Open the moving map in another screen 

You can open the moving map in a second monitor 

  
The moving map window position will be stored. This module will open each time at the previous 

location and size. 

 

3.9 Position settings 

 

After any modification, you need to restart the application 



IFR/VFR Mode Choose between VFR or IFR patterm. It modifies the altitude and 
distance for downing legs (5000’’ for IFR / 1000’’ for VFR) 

Additional length Depending on the used aircraft, you can be too close or far from 
the gate. Set this value. 

Searched type of gate Restricts the parking list according to your aircraft category. i.e. for 
a B737, keep only Ramp & Gate medium. 

Pause after a move / and 
ask to unfreeze 

When you click on "Pause after a move", a checkbox appears "and 
ask to unfreeze". It displays an explicit "UNFREEZE" message after 
moving the aircraft. 
 

Disable Set auto ILS & QNH Uncheck = Position Module allows you setting auto ILS frequency 
and QNH 

 
 

3.9.1 Helipad Support 

To use helipad, Activate this feature from the configuration menu > Position

 

 

The helipad will appear on the Position and Map pages. 

 
 



 

3.10 Black Box settings 

 

By clicking on “Google Earth tracking activation” you allow following the aircraft in real time in 

Google Earth.

 

You can change the plane color from black to red 

 

 



You can add the Air Traffic (AI) (green arrows)

 

 

3.11 Remote Computers settings 

 



3.12 Motion settings 

 

4 Licenses 

4.1.1 Two different licenses: Commercial/integrators and Home user releases 

FS Instructor is a payware application. It’s a one-time deal. You pay only once (no annual fees). 

When you start the software, you need a key code. Without this code, the program runs in demo 

mode and stops automatically (from 5min for the first utilizations to 30 sec after a while). You have 

time to discover the different features before to decide to buy, or not, a license. 

Who can buy a Home User License? 

Only people who builds a simulator at home for their own use and not make money. Pilots 

who access to this simulator doesn’t’ have to pay for it.  

In all other cases, you need a professional license:  

If you are an association, a flight school, a company, a simulator renter or if you sell 

something linked to the instructor station, so we consider you to be a professional user. 

The commercial license is distributed from http://fsinstructor.com site 

http://fsinstructor.com/


The key code is unique to your computer. It means that if you want to install the application on 

another computer, or if you modify your computer, you will need a new license code. 

  

 

Here, the installation ID is «DA8B-C713-79D4». It can be sent by pressing the « 2 – PURCHASED 

PRODUCT REQUEST MY KEY » button. It must be accompanied of: 

- The order’s date  

- Your name 

You will receive your key by e-mail in the next hours. 

Copy the license key in the ”Insert your key” filed.

 

4.1.2 What are the different licenses 

The commercial/integrator license has the same features as Home user version excepted: 

- Home has no screen customization (to show another aircraft in the module background) 

- Home has no Splash screen customization with your own logo 

- Home has a plash screen during 7 sec that you can’t by-pass. 

- Multiple FS Instructor instances or screens is able only in the commercial version 



Commercial license allows some specific services like an extended support. See chapter 25 

Additional service for professional 

4.2 Prepar3D / Flight Simulator connection 
 FS Instructor communicates with FS through FSUIPC. If Flight Simulator and FS Instructor are 

installed on different computers, you must use WideFS. 

 The connection begins as soon as the program is launched. So, you have to start Flight 

Simulator and WideFS (if you need it) prior FS Instructor  

 The reconnection is automatic as soon as FS Instructor find Flight Simulator. 

 Note : the rest of the application is disable when the connection fails or if you load, slew or 

pause FS. 

  



5 Multi-screens 
You have two ways to manage multi-screen. It requires a commercial license 

If you want to keep the tab menu on each screen:  

- Duplicate your FS Instructor directory for each instance. Each one records his own pages list and 

own windows location 

- From the setting page, set Pages to be open in an external view. Such as 

 
 

6 POSITION PAGE 
It moves your aircraft to your own location, on a pattern, in flight, on approach or on the runway.  

Insert an ICAO code into the search box. 

 

If the ICAO code is known, the runway and parking part are displayed. 

   



You have three areas: 

- Position regarding a runway 

- Choose a parking stand 

- Create/load a preset situation 

6.1 Choose a runway 

 

Here , we choose the 09 runway (green)  

So, the available runways list opens automatically. As soon as you select one runway, the Runway 

information block is updated. It shows you: 

- The runway length (feet) 

- The Altitude (feet) 

- The QFU (runway heading) 

- An ILS frequency (if available) 

- The type of surface (water, macadam…) 

 
 

6.2 Choose a position (middle part) 

 

When you’ve selected a runway, you access to 9 preset positions : 

o One on the runway, ready to take-off (T/O) 

o Approach locations : 

▪ Short Final (4NM / 150kts) 

▪ Final (7NM / 170 kts) 

▪ Approache (10NM / 200 kts) 



▪ Before the descent (15NM / 220 kts) 

▪ Interception left and right (20NM) 

o 2 Tailwinds position (5000’’/240 kts) 

On the left, two cruising situations in “In Flight” block : for the flight level 

100 (FL100) and 250 (FL250).  

 

 

 

 

When you select a position, you have to confirm it : 

  

Create your own position (only pro license): 

If the seven preset positions are not enough your you, you can use 

the "Create a position” button : 

  
So, you have the possibility to choose your: 

Altitude: compared with the runway altitude (AGL) 

Heading: aircraft heading 

Speed: desired GROUND speed (kts) 

From the runway 

  Position in relation to the choosed runway (angle and distance with the 

  runway) 

 Coordinates 

Move the aircraft to coordinates. 

Pratical to move the aircart on an IAF. 

In this mode, the entered altitude is AMSL (Above Mean Sea Level). 



3 – Settings (bottom part) 

  

In the “Settings” block: 

- Set ILS frequency is shown only when the runway owns ILS. It tunes ILS frequency as soon as 

you load a position. 

- Set QNH set altimeter to the local pressure. 

- IAS allows starting position with the desire speed (optional). 

- Trim is very important. It forces a trim position. The value (from -7 to 12) depends on your 

aircraft. We advise to try the value « 2 ». Fine tune this value. 

Advices 

When you move to approach, check : 

▪ The wind 

▪ The gear, airbrakes & flaps 

▪ The parking brake 

▪ The throttles position 

▪ The engines started 

▪ A/P OFF 

6.3 Parking place  

It moves the plane on a specific place on an airport.

 

The stand list appears automatically when you insert an ICAO code and parking exists. 
 
Just click on one of them 

 

When you click on the button to move the aircraft. Safely, pilots 
must set parking brakes and to idle throttle.  
During the procedure, you can see the status bar progresses 
(bottom of the screen) 

 
 



Depending on the used aircraft, you can be too close or far from the gate. Set this distance in the 

setting menu > POSITION > move to a gate 

 

  



6.4 Save and load situations 

6.4.1 To load a situation 

On the left, you have a “Situation” button   

This screen appears with all previous recorded situation 

 

 

Note: When you save a situation, it’s stored on the local HD. It means that if you use several FS 

Instructor, each one sees only the situations created on their machine. 

Choose a recorded situation 

The entered description 

If you plane position has 

been recorded on the 

ground or in flight 

The record date 



6.4.2 To save a situation 

 

It is interesting to record a 

situation. Such as to practice 

procedures and to be able to 

retry many times easily. 

To save a new situation. Click on 

“Save a new situation”. 

 

This action is invisible for pilots 

It’s mandatory to insert a 

situation name. We advise to 

add a description. It permits to 

remember the plane location, 

which aircraft was using…  

You can enter several lines. 

The SAVE button is enabled only when you have entered a situation name. 

Beware of not using an existing name situation. 

If you recorded it with FS Instructor, a warning appears and asks you 

to change this name. 

If you didn’t record it with FS Instructor the situation will be erased 

without control. 

It saves: 

- The plane used and his location 

- Fuel state 

- Weather 

- Radio/Com settings 

- Engines states 

IMPORTANT NOTE: Flight Simulator saves the situation when you close Prepar3D/FS. If you kill Flight 

Simulator, the current situations are lost. So, close it properly. 

6.5 RADIO COM 
The radio com button is accessible from the POSITION and RADIO pages. 

You can find a Radio frequency from an ICAO code. Buttons send the desire frequency 

on COM1, COM1 Standby, COM2 or COM2 standby. 



 

 

7 ENVIRONMENT PAGE  
This page manages weather condition, Time and Traffic. 

   

7.1 Weather part 

 

1 – Control buttons 

2 

1 

3 

4 

5 



• SEND to send the selected weather modification to the simulator 

• RELOAD to reload the weather (to be sure to have the latest values) 

2 - Direct Weather Preset 

• Note: Apart Cavok (Ceiling And Visibility OK) the other presets own random settings. If you 

choose twice a storm. You will not have the same ceiling, wind and turbulence. 

3 - Your Preset. 

You can record your own Weather situation. Click on one of the four buttons. 

 
 

SELECT: Loads only 

SELECT AND SEND: Select and Send the weather preset 

Save:  Save the current weather settings. A name will be asked. 

4 - Visibility: Visibility part 

You can insert a value for the visibility or use the + / - buttons. 

 Note, you have to click on Send button to validate. 

For training, a rapid access is given to the different minima, by category. 

From Wikipedia: 

 

 

 

 

 

 

 

 

 

• Category I (CAT I) – A precision instrument approach and landing with a decision height not lower than 
200 feet (61 m) above touchdown zone elevation and with either a visibility not less than 800 meters or 
2400ft or a runway visual range not less than 550 meters (1,800 ft) on a runway with touchdown zone 
and runway centerline lighting . 

• Category II (CAT II) – A precision instrument approach and landing with a decision height lower than 
200 feet (61 m) above touchdown zone elevation but not lower than 100 feet (30 m), and a runway 
visual range not less than 300 meters (980 ft) for aircraft approach category A, B, C and not less than 
350 meters (1,150 ft) for aircraft approach category D. 

• Category III (CAT III) is subdivided into three sections:  
o Category III A – A precision instrument approach and landing with:  

▪ a) a decision height lower than 100 feet (30 m) above touchdown zone elevation, or 
no decision height (alert height); and 

▪ b) a runway visual range not less than 200 meters (660 ft). 
o Category III B – A precision instrument approach and landing with:  

▪ a) a decision height lower than 50 feet (15 m) above touchdown zone elevation, or no 
decision height (alert height); and 

▪ b) a runway visual range less than 200 meters (660 ft) but not less than 75 meters 
(246 ft). Autopilot is used until taxi-speed. In the United States, FAA criteria for CAT III 
B runway visual range allows readings as low as 150 ft (46 m). 

o Category III C – A precision instrument approach and landing with no decision height and no 
runway visual range limitations. This category is not yet in operation anywhere in the world, 

as it requires guidance to taxi in zero visibility as well. "Category III C" is not mentioned in EU-
OPS. Category III B is currently the best available system. 

http://en.wikipedia.org/wiki/Instrument_landing_system
http://en.wikipedia.org/wiki/Runway_visual_range
http://en.wikipedia.org/wiki/Aircraft_approach_category


Select the required approach type and click the Send button. The visibility will be change according 

your choice. 

5 – Current status:  

◼ In progress: data sending 

◼ Checking: data checking 

7.2 Weather Advanced settings 

If you click on “Show Advanced settings” part, it shows you the complete weather set. 

 

Here, you can set precisely: 

- 2 ceilings (type of clouds, turbulence, precipitation, icing, coverage…) 

- One wind layer (from ground to FL360) 

- Ground Temperature 

- Local QNH 

Note:  

- When you sent a weather setting, I could take few seconds to take into account (sometime 20 

sec). It’s due to a Flight Simulator limitation. 

- This is a global setting. That means that there is one weather configuration to all the FS scenery.  

7.3 Change Time  
 DAY / NIGHT : as soon as you click on these buttons it 

changes Simulator time 

MORE open a widow to choose the time and the season  

Beware of using this panel airborne: the scenery will be 

refreshing during several seconds.  

  



7.4 Traffic 

7.4.1 Generic IA 

You can control if you want traffic (IA). 

 

Here, none traffic. 
Click on “ON” to activate traffic 

 

Here, you have the traffic maximum (100%). 
 
You can reduce it (minus button) or stop it (OFF button) 

 

Here, you have 40% of traffic. 
 
You can reduce it (minus button) or increase it (plus button) 

 

When you start or increase the traffic, it reloads the scenery. It could disturb the pilots. 

By default, general aviation is OFF (0%). If you want to keep GA you have to activate this option in the 

Settings window 

 

 



7.4.2 TCAS ALERT 

 

The button TCAS ALERT opens a window. 

Insert the detail of the new plane that you 

want to create. 

When you are ready, click “GENERATE” 

button and a new TCAS aircraft is created. 

 

 

 

 

This TCAS Alert generates a traffic into the TCAS screen. 

Note: you don’t see the plane in the Flight Simulator view. It appears 

only on your TCAS   

  

To remove this aircraft, click on «  STOP IT ». The TCAS aircraft disapears after some seconds. 

7.5 Simulation rate time 
You can speed up the simulator X2. You can come back to a real time flight 

(X1). 

The mode in progress is on green.  

  



8 FUEL PAGE  
This screen manages the fuel into the different tanks.   

FS Instructor supports RIGHT, CENTER, LEFT, AUX LEFT, AUX RIGHT, EXTERNAL 1 and EXTERNAL 2 

tanks.

 

The number of shown tanks depends on the current aircraft. If you load another aircraft, it is 

automatically updated. 

 

1 – Refueling mode: switches to the edition mode (to field tanks) 

2 

1 

3 



2 – Actual fuel quantity in the tank (here 3,928 kg in the right tank)  

3 – Fuel level. There are three color codes: 

• Blue over 40%   

• Orange between 20 and 40%   

• Red below 20%   

 

8.1 Refueling mode 

By clicking on « refueling Mode», you access to the fuel loading window:

 

4 – Two quick presets: Half and Full tanks 

5 – Desired fuel quantity. 

You can choose an inferior value of the fuel quantity. Tank will be emptied.  If you ask more than the 

tank capacity, the extra will be ignored. Plus and minus button allow you to you a tactile screen. 

6 – The total asked is shown here 

7 – Choose the desired time to refuel (from 0 to 20min). Tanks will be progressively filled during 

indicated time (0=immediately).  

8 – Load the tanks appears only when you change a value tank.  

7 

5

2 

4 

6
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9 – STOP REFUELING button  

10 –refueling progression bar. 

To know 

- During the procedure, the FSUIPC 66C0 variable is set to 1. Cockpit builders can read this offset 

to create a «  Fueling door open » alarm. 

- During the filling, the window can be closed. You can monitoring the refueling procedure in the 

title bar.  

 

8.2 Refueling Preference 
Menu > File > Settings > UNITS & FUEL

 

9 
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8.2.1 Refuel only with engines stopped 

To improve realism, this option prevents refueling before engines stopped.  

8.2.2 Use kg/lb 

According your need, you can use kg instead of lb.  

8.2.3 Customize this screen 

Professional users can change the background to display their own aircraft.  

 

8.3 Frozen tank feature 
For procedure training you can freeze the aircraft weight during the flight. 

If you press the “Freeze tank” button, it locks the fuel consumption 

until you press again. 

Note: you can still use refueling feature to add or remove fuel. 

  



9 PUSHBACK PAGE 
With this page, you manage pushback. It tows the aircraft to move it ready to taxi.  

 

9.1 Procedure 
You have three different pushbacks.  

1 – Nose to the Right. Here you can note that 

it turns the plane to the South-East 

(“Heading: SE”) 

2 – Straight away 

3 – Nose to the left 

You can begin by a direct push (2) and chose 

during taxi to turn with the button left (1) or 

right (2) 

 

When a pushback is in progress the arrow 

corresponding to the choose direction blinks (in 

blue). 

The status (4) comes to “Pushback in progress” 

 

You have to release the parking brake. If not, this 

message appears: “ ” 

5 – If you have previously chosen an airport and a gate, this information is displayed into an 

“information” part. 

Note: the pushback page is not accessible during airborne. 

 

2 
Straight 

Counter  

Clockwise Clockwise 1 3 

 

2 

4 

3 1 

5 



9.2 Customize this screen 
Commercial users can change the background to display their own aircraft. Please contact us to 

receive the procedure. 

10 STANDARD FAILURES 
By default, FS Instructor uses the FS/Prepar3D standard failures. 

You can change these settings to have supports Project Magenta or PROSIM. They have their own 

failures module. 

 
 

CUSTOM FAILURES 

 

In RED: the current sent failure 

In Orange: Trigger malfunctions. They aren’t yet applied. You can click on the orange button to know 

the trigger condition. 



10.1.1 Send or arm a failure 

Click on a page button and on a failure button.

 

This screen allows to send a direct failure (button green SEND) or field trigger conditions. You can 

cumulate the three following settings: 

- Delay to postpone the failure effect. 0=now. When you change this value, it shows you the time 

(according the instructor station clock) when the failure will be sent: 

  
- Indicateed Air Speed - Above (+)/Lower (-) knots 

- Altitude of the aircraft - Above (+)/Lower (-) feet 

In the following example, we want to create a failure in 25 min when IAS will be < 210 kts and ALT < 

5000. 

 



The green button “SEND” becomes orange and indicates now “ARM”. It means the failure will be 

armed and not sent now. Click on this button. 

 

The failure becomes orange (ARMED status). If you click again on this button, you can see the current 

conditions: 

 

Now there are 6 minutes remaining. You can Remove these armed failures with the “REMOVE” 

button or change conditions. 

When all conditions are true, the armed failure is sent and becomes RED.

 

To remove the failure, click again on this red button. 

Note: PITOT and VACUUM failures worked only with FS2004. 



10.1.2 Available standard P3D failures list 

FAILURES 
 

 
HYDRAULIC  
BRAKES L  
BRAKES R  
ADF  
IAS  
ALTIMETER  
ALTITUDE INDICATOR  
COMPASS  
ELECTRICS  
ENGINE L  
ENGINE R  
HEADING INDICATOR  
VSI  
TRANSPONDER  
PITOT  
HYDRAULIC SYSTEM INTEGRITY 
50% 

INHIBIT 
 

 
FLAPS  
SPOILER  
GEAR  
REVERSER ENG 1  
REVERSER ENG 2  
LEFT BRAKE  
RIGHT BRAKE 

FAILED 
 

 
ENGINE 1  
ENGINE 2  
FIRE ENGINE 1  
FIRE ENGINE 2  
AP  
HYDRAULIC  
GEN 1  
GEN 2  
AVIONIC  
STATIC PORT  
VACUUM  
PITOT (IAS)  
ELECTRICITY 

 

Useful 



- If you use some add-ons or FSUIPC special functionalities, it could happen that some failures 

don’t work. 

- At the end of the flight, the Logbook gives a list of used failures (comment part) 

 

10.1.3 RANDOM failures 

It allows creating random failures with 5 reliable levels: 

LEVEL RELIABILITY 

Never  None failure 

Reliable  About one for 50 hours of flight 

Sometimes  About one for 20 hours of flight 

Often  About one every 3h of flight 

Garbage  One problem or more for 1h 

 

Useful 

• The random failures are only generated airborne. Newer on ground. 

• The reliability level is recorded. It’s reused for the next FS instructor start 

10.1.4 Customize these failures 

You can create your own failures to manage Project Magenta Offset or all specific features from 

FSUIPC. 

Copy the file failure.txt from the FS instructor installation folder, resource directory

 and MOVE IT in your FS Instructor/CUSTOM directory:  

 

Structure of this file: 



- All comment have to begin by a quote “ ’ ”. Such as:  

 
- You create PAGE with the sign [ and ]. Such as: [PM BLEED] 

- You declare two kinds of FSUIPC variables: 

o Simple offset 

You give a failure title, FSUIPC offset, variable length or bit, value when fail, value when 

normal and say if the failure value is repeated every second 

o TOGGLE. It’s a ON/OFF mode. They are documented into the FSUIPC SDK (List of 

Controls.pdf, such as 

http://fsuipc.simflight.com/beta/Revised_List_of_FSX_Controls.pdf) 

- Each field has to be separated with a coma 

To know which FSUIPC offset you have to use, please check FSUIPC SDK documentation or your plane 

system suit like Project Magenta. http://www.projectmagenta.com/all-fsuipc-offsets/ 

When you close FS Instructor, the failures are reset. 

Beware: 

- If you forgot one coma into your offset declaration, the variable will not appear 

- The failures are only known during your FS instructor session. It means that if you use a second 

Instructor session, it can’t see the current failures. Furthermore, if you restart Fs Instructor you 

no more know which failures are in progress 

- Newer used reserved keywords (TOGGLE/REPEAT) in the offset description 

10.1.4.1 How to switch off the avionics 

The FSUIPC documentation shows the offset 2E80, size=4 

 

You have to declare:  

AVIONIC, 2E80, 4, 0, 1, REPEAT 

We add REPEAT mode to send AVIONIC OFF every second. 

http://fsuipc.simflight.com/beta/Revised_List_of_FSX_Controls.pdf
http://www.projectmagenta.com/all-fsuipc-offsets/


10.1.4.2 How to inhibit spoiler 

The FSUIPC documentation shows the offset 32F8 and the bit 1

 

You have to declare:  

SPOILER, 32F8, .1, 1, 0 

10.1.4.3 How to stick brakes 

The FSUIPC controls shows the toggle 66310 

 

You declare 

STUCK BRAKE, TOGGLE, 66310   

Note: for toggle mode, you can’t specify a fail and normal value. It’s like a switch. It sends ON for the 

first use and OFF the second time. 



 

 

11 PROSIM support 

If you set PROSIM, you have access to specific features: 

o PROSIM Failures 

o FMS 

o Flight Plan on the MAP 

o GPU control on Aircraft page 

11.1.1 Prosim Setting 

FS Instructor needs to know where is located PROSIM737. You have to set it into the preference 

window (PROSIM, PM tab) and check “Use PROSIM”.  

   

You have to insert Host name/IP Address and the default com Port (8080 by default) 

The Test button tries a connection to PROSIM 



If after a while PROSIM is not 

found, you have to check 

that your settings are correct 

and PROSIM is started. 

 

 

 

 

In Prosim setting, you have to declare  

To have the green arc of the altitude selected on MCP 

 

 

 



11.1.2 PROSIM FAILURES PAGE 

 

If you own PROSIM737, FS Instructor can manage the failures panel. 

This page sends or stops failures. 

The screen is divided in 3 parts: 

• On the left, you have the 9 domains. If you click on one of them, the corresponding 

failures appears on the center part 

• The center part displays the failures list of the current domain (in green). 

If you move the mouse on a failure, it shows details 



 When you click on a failure, a window allows to send now the malfunction or to arm it with 

conditions: 

 

Here we arm a Fire Engine in 1 hour above FL300 

Details on this trigger window: 10.1.1 Send or arm a failure

 

On the right 

• In red, the current failures. Just click on it to remove it. 

Beware: when you stop a failure, such as Engine failure, it stops the reason why the failure 

appears. Pilots have to restart the engine. 

• In orange, the armed failure. Click on it to show the current trigger conditions. 

11.1.3 List of the Prosim failures (for ProSim737 V1.x) 

Battery  Navigation 

   Generator 1     IRS left 

   Generator 1 disconnect     IRS left alignment 

   Generator 2     IRS right 

   Generator 2 disconnect     IRS right alignment 

   TR 1 failure     GPS 

   TR 2 failure    
   TR 3 failure  Pneumatic 

   Static inverter     Trim air valve 



   Source off left     L Bleed trip 

   Source off right     L High stage locked close 

 
 

    L Bleed Stage shift 

Busses     R Bleed trip 

   TransBus1     R High stage locked close 

   TransBus2     R Bleed Stage shift 

   MainBus1     Bleed air valve left 

   MainBus2     Bleed air valve right 

   GalleyBusLeft     Bleed air valve APU 

   GalleyBusRight     Pack L 

   ACStandbyBus     Pack R 

   DCBus1     Pressure loss high 

   DCBus2     Pressure loss low 

   DCStandbyBus     Pressuration controller 1 

   BattBus     Pressuration controller 2 

   HotBattBus     Passenger oxygen 

   SwitchedHotBattBus     Pneumatic isolation valve 

   GroundServicesBus     Duct leak L 

   switchedground     Duct leak R 

   Aux Battery     Cowl overpressure L 

      Cowl overpressure R 

Fuel      
   Fuel Left Aft pump  Hydraulic 

   Fuel Left Fwd pump     Hyd ENG1 

   Fuel Center Aft pump     Hyd ENG2 

   Fuel Center Fwd pump     Hyd ELEC2 overheat 

   Fuel Right Aft pump     Hyd ELEC1 overheat 

   Fuel Right Fwd pump     Hyd Standby pump 

   Crossfeed valve     Standby hyd low quantity 

   ENG fuel valve left    
   ENG fuel valve right  Engine 

   Spar valve left     APU 

   Spar valve right     Engine 1 failure 

   Filter bypass left     Engine 2 failure 

   Filter bypass right     Fire engine 1 

 
 

    Fire engine 2 

Heating     Fire APU 

   Capt Pitot Heat     Overheat engine 1 

   Alpha Vane Heat L     Overheat engine 2 

   Elev pitot Heat L     L bottle discharged 

   tempProbe Heat     R bottle discharged 

   Copilot Pitot Heat     APU bottle discharged 

   Alpha Vane Heat R     Engine 1 loop A 

   Elev pitot Heat R     Engine 1 loop B 

   auxPitot Heat     Engine 2 loop A 



   Window heat Side L element     Engine 2 loop B 

   Window heat FWD L element     APU loop 

   Window heat Side R element    
   Window heat FWD R element    
   Cowl valve L    
   Cowl valve R    
   WAI valve L    
   WAI valve R    

     
Misc       

   Speed trim fail      Fwd Cargo door 

   Mach trim fail      Aft Cargo door 

   Auto slat fail      DEU 1 failure 

   Equip door      DEU 2 failure 

   Fwd entry door      Lavatory smoke 

   Left Fwd Overwing door      Cargo fire fwd 

   Left Aft Overwing door      Cargo fire fwd detection loop A 

   Aft Entry door      Cargo fire fwd detection loop B 

   Fwd Service door      Cargo fire aft 

   Right Fwd Overwing door      Cargo fire aft detection loop A 

   Right Aft Overwing door      Cargo fire aft detection loop B 

   Aft Service door       

 



11.1.4 PROSIM FMS 

 

This module is accessible if you have set a connection to PROSIM from the Preference menu. 

It extracts information from the route inserted in the CDU. 

To be able to display an embedded CDU (SHOW/HIDE CDU button) you need at least one ProSimCDU 

program running. 

FS Instructor opens a web window to the PROSIM CDU. 



11.2 PROSIM FLIGHT PLAN 

 

12 PROJECT MAGENTA support 

If you set PM, you have access to specific features: 

o FMS 

o Flight Plan on the MAP 

 

12.1.1 PM Setting 

FS Instructor needs to know where is located the NetDir directory. This folder shares all Project 

Magenta information in real time. Check your PM setting to know where it is.

    



12.2 Project Magenta FMS 

 

12.3 Project Magenta Flight Plan 

 

13 WEIGHT/PAYLOAD PAGE 
This module shows you the current aircraft weight. It controls the payload elements (pilot, first class, 

baggage…). 



This station list depends on the current aircraft used. 

 

The values are only sent when you click on “Send” button.  

During the flight, the plane could have an abrupt behavior if you change the mass a lot. 

Note: 

• You can insert aberrant value. For example, 2t for 

the pilot weight. It should have a very strong 

impact on the aircraft. It could be unflyable. 

• Max Gross Weight: if you exceed this value, the 

aircraft weight appears in red. You can ignore this 

warning and send excessive values. However, the 

flight envelope will change and the plane could be 

unstable. 

• After a crash or situation loading, these weights 

could be come back to the default values. 

• If you try to update weight station during a flight 

(engine started), you will have to confirm it (a 

message box appears) 



• You can use lb or kg. Select the unit it into setting menu (UNITS Part). 

  
 

14 Aircraft  

14.1 General Page 

  

This page can change regarding your current aircraft and add-on used. 

  

This page monitors the aircraft status. 

You detect quickly pilot errors via color codes (orange: potential error, red: danger) 



 

IAS (Indicated Air Speed):  
The value becomes red if the plane exceeds 250Kt 
limitation under 10 000’ or if the plane exceeds 30kts 
during taxi. 

 
TAS (True Air Speed)  
 
 

 
 
 
 
 
 

Alt: True Altitude (Ft., at sea level) 
 
Height: Ground height 
 
Baro: atmospheric pressure setting 

• Above 7000’, if QNH is not set to 1013 
(standard pressure), the value appears in red 
 

Local QNH: atmospheric pressure 
 
 

 
 
 
 
 
 

 
 
 
 

Flaps: indicates the current flaps position (degrees) 
If you click on “Flaps” button you can choose to up or 
down flaps. 
Note: according your aircraft, you have to specify the 
full flaps degrees value to have. Such as 40° for B737. 
Go to preference menu, aircraft tab to change this 
value. 

 
Spoilers: indicates in % speed brakes position 

• 0% = up / 100% = fully extended 

• When spoilers are armed, ARMED text 
appears.  

• When speed brakes are fully extended, the 
value appears in red. 

• If you click on Spoilers. You release or extend 
the spoilers. 
 

Gear: indicates the landing gear position. 

• Black: Gear up,  

• Red: In transition, gear unsafe.  

• Green: Gear down and locked 
These buttons can be activated to move the landing 
gear. 
 
 

 

Actual Weather around the aircraft: 
- Wind direction 
- Wind speed 
- External temperature (Celsius) 
 
 



 
 
 
 
 

Pitch.  

• /\ indicates a climb pitch 

• \/ indicates a descent pitch 
 

Bank: Bank angle:  

• <-- to the left 

• --> to the right 

• Becomes orange when reaching 30°  

• Becomes red when reaching 50° 
 

Heading compass. 
 
G Force: Gravitational Force  

• Becomes red after 2g 
 

Vertical speed  

• appears in orange after 3000’’/min 

• Appears in red after 4000’’/min 
 

 

Shown engines N1 in % 

• Becomes red under 20% and over 90% 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Lights / Pitot heat 
 

• Nav Light should be ON during the flight 
 

• Pitot Heat: Not mandatory but avoid using it 
on the ground 
 

• Beacon should be ON when the engines are 
started 
 

• Strobe should be ON when you line up and OFF 
runway vacated 
 

• Landing: has to be ON when you line up and 
below the transition altitude (or FL100)  
 

• Taxi  
 

GPU / UNPLUG GPU appears only when Prosim is 
activated. It controls ground power. 
 
Park Brake: Parking brakes status: 

• Red, Parking brakes engaged/set 

• Black, parking brakes released.  
 
Door: Door status  

• Black: Door locked,  



• Red: Door opened.  
 
 

Pilotage errors appear in the logbook page. Only highest values will be written. 

14.2 RAVIO/NAV page 

 

14.2.1 NAV 1, 2 tuning 

 

1 – Active NAV1 or 2 Frequency (read only) 

2 – Swap frequency button  

3 – STANDBY Frequency (read only)  

4 - Standby Frequency writing box. Click on the left arrow to send it. 

5 - Course setting (OBS) of each NAV. You can write a value. 

6 - DME distance (0=not available) 

7 – ID = IDENT. To listen to the Morse code. Green button=activated 

8 – If you are receiving a VOR. It shows the code and navaids name. 

14.2.2 COMM tuning 

 

 

 
 
1 –Active Frequency (read only) 
2 –Standby Frequency (read only) 
3 –Frequency change button 
4 –New Standby Frequency writing 
box 
5 – Button to send this frequency 

1 2 

4 
5 

3 

1 

2 

3 4 5 

6 

7 

8 



 
 

14.2.3 NDB 

 

ADF 2 works only with aircraft supporting a second ADF. 

1- ADF Frequency – you can write a new value 

2 - ID = IDENT. To listen to the Morse code. Green button=activated 3 –Frequency change button 

3 – If you are receiving an ADF. It shows the code and navaids name. 

14.2.4 Transponder 

 

1 –XPDER Frequency – you can write a new value 

2 – left arrow only appears in edit mode. Click on this button to send the actual XPDER value 

 

14.3 Module settings 
The flaps position is calculated regarding the max full flaps degrees. It depends on your current 

aircraft. You can manage it from the Menu Config > General

 

15 MOVING MAP 
A moving map display is a type of navigation system that shows the aircraft current location at the 

center of a map. As the plane moves, the map moves to keep it at the center of the display.   

1 
2 
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15.1 “Obsolete navaids database” message 
If a message “Obsolete navaids database” appears on the 

map, it means that you are not using a Navigraph database. 

Please follow this chapter to download and install the last 

Navigraph database:  

 

 

 

 

 

 

15.2 Zoom 
By default, auto zoom is activated. The scale depends on the plane altitude. On ground, 

the focus is on the airport. To bypass, click on the “AutoZoom ON” button.  

Two new buttons appear. You can now manage manually the zoom.  

 

Two different ways to zoom: 

- Use mouse wheel scroll (in/out) 

- Use buttons  

 



15.3 The controls 
On the left, you find buttons.

  

Gray button = inactive 

Orange button = first notch 

Green button = ON or second notch 

15.3.1  ICAO  

This button has three states: 

None (gray button) Show airport circle (orange button) Show ICAO code (green button) 

   

15.3.2 RUNWAY 

This button has three states: 

None (gray button) Show runway (orange button) Show runway identification (green 
button) 

   
 



Note: you can filter the runways displayed according the surface (see Menu > Settings > POSITION) 

 

15.3.3 ILS 

This feature works only if you display the runway. This button has three states: 

None (gray button) Show ILS track (orange button) Show ILS frequency (green button) 

   

15.3.4 AXE 

This feature works only if you display the runway. This button is ON/OFF: 

None (gray button) Show Axe (green button) 

  
 

 

15.3.5 TAXI/PARK 

This feature works only with a high zoom. This button has three states: 

None (gray button) Taxiways (orange button) Taxiways designator and Parking 
(green button) 



   
Note: to work, you have to build the sim database with the taxiway checkbox activated. 

15.3.6 Flight Information 

Switch to show aircraft information 

 

15.3.7 Rose 

Show a heading rose 

 



15.3.8 PLOT 

Track the aircraft (blue line) 

 

 

15.3.9 A.I. 

It displays the other aircrafts. 

This button has three states: 

- None (gray button) 

- Airborne aircrafts (orange button) 

 
o The yellow aircrafts fly at between 500 and 1 000’’ of your current altitude. 

o The red aircraft fly nearly at the same altitude as your airplane 



- Airborne and ground aircrafts (green button)

 

 

15.3.10 VOR 

This button has three states: 

None (gray button) Show VOR position, ID and 
frequency in green (orange 

button) 

Add a rose 

   
 

15.3.11 ADF 

This button has three states: 

None (gray button) Show ADF position, ID and 
frequency in magenta (orange 

button) 

Ad a rose 

   
 



15.3.12 WAYPOINTS 

It an ON/OFF feature. Beware it has strong impact on performance.

 

 

15.3.13 Flight Plan 

This button is only accessible if PROSIM or Project magenta is set and connected. 



Orange button shows only Flight plan path. 

Green button shows the Waypoint ID. 

 

15.4 The contextual menu 
By clicking on the map, you display a contextual menu 

 

15.4.1 Export Map 

 
Export map gives access to two features: 

- Print the map 



It prints the map on your printer. An option in the SETTINGS windows uses a white background 

instead of black. 

You have set a printer from MENU > Settings > MOVING MAP.

 
 

Take a screenshot 

It exports a png file in the OUPUT directory 

 

15.4.2 Center screen here 

 

It centers the map on the clicked point. 

15.4.3 Distance and bearing of one point on the map 

When you click on the map, the menu appears. In yellow, you find the bearing and distance of this 

point to the aircraft. 

 



15.4.4 Measure 

 

Measure creates an arrow with distance and bearing to the selected point. 

15.5 User objects 

User map objects are graphic elements added on the map. Such as: 

 



From a map click, you display a contextual menu 

 

 

It is used to add some information on the map 



15.5.1 User object: Text 

It adds a free text on the map. 

 

 

15.5.2 User object: Vector 

It creates lines. You can change the start and end cap (to create arrow) and modify the line style (dot, 

dash, fulled)  

 

15.5.3 User object: curve 

It draws curve on the map based on 3 points: 



- 1 – a start point 

- 2 – an end point 

- 3 – an intermediate point 

 

15.5.4 User object: Point 

Add you waypoint on the map: 

 

15.5.5 User object: Rectangle 

Create squares and rectangles 

Start point 

End point 

intermediate point -> 



 

15.5.6 User object: Circle 

 

 

 

15.5.7 Custom objects manager 

All your custom objects added on the map are managed from 

map click>Manage the user objects. 

 

 

 



It opens a dedicated window 

 

You can save your current list of objects into preset files. 

These presets are stored as xml_UO files located in your FS 

instructor / SETTINGS directory 

If you create objects and don’t save the preset, you will not find 

your objects at the next session. 

You can manage several presets:

 

 



15.6 FIND button 
Find button opens a window to find a database record: Airports, VOR, NDB and waypoints. 

Insert at least 2 characters in the IDENT filed to search records. 

 

We use “KLA”. It gives all ICAO containing this string. 

 



By selecting an airport, the SID, STAR and APP lists appear.

 
You have selected KLAS airport, you can choose a SID or STAR or APPROACH or just click on “MAP on 

AIPORT KLAS” green button. 

The map is centered on our airport 

 



When you select an airport, you access to the SID/STAR and APPROACH. 

 

If this procedure owns different runways and Transition, a new window asks you to select mode 

information. When you have selected all available information, the green button “SEND IT TO THE 

MAP” appears. 

 
Our SID appears on the map. You could have to change zoom value to see your SID. A new button is 



added (here SID: LAXX7). If you click on it, it remove the SID path. 

 

You can display on the map, at the same time, one SID, one STAR and one APP. In this picture, we see 

a STAR and his APProach on LFPG.

 

 



16 BLACK BOX PAGE 
For debriefing, you have some tools located into the black Box page.

 

16.1 Flight Recording 

During a flight, several kinds of file are generated: 

• A raw flight log (csv file) that you can use to brief and create your own graphs. 

• a Google Earth file to show your flight profile, events and mistakes 

• a landing report (pdf format) 

16.1.1 Control the files creation 

The record feature is automatic. You can force a new file by clicking on “Save the Flight 

Records” button. 

 

New flight files are created when: 

▪ The plane crashes 

▪ You move the plane to a position 

▪ Engines start 

 



Then, you can open the files by using these following buttons 

 
 

The files name uses the current session label . So, you can find 

easly a previous flight. Such as 

 

16.1.2 Google Earth Flight recorder 

Automatically, each flight is recorded into a Google Earth file (kml extension). 

It includes Navaid (VOR/ADF) near of the route. 

It records Extra Data. Shows on the flight trace some different information: 

o Flaps/Gear shows Flaps UP, Flaps Down, Gear Up et Gear Down 

o Bank Angle > x° Show bank angle overshooting. This value is editable in the preferences 

(menu > preferences). 

o V/S > xxxx’’/min: shows vertical speed excesses.  

o Overspeed: VNE exceeding 

o Stall: already not implemented 

o AP: Autopilot ON and OFF 

The .kml file can be opened with Google earth by clicking on “Open a Google Earth Flight”. Also, you 

will find these files into your FS Instructor/OUTPUT directory. 



 

VOR DME example (Nantes)

 

 

 

 

 



16.1.3 CSV Flight logs 

The first line is the header with the startup date/hour  

 

16.2 Real-Time graphs 

 

These buttons allow displaying real-time graphs. 

1 – Approach graphs 

2 – Parameters graphs 

You can choose to see ALT, AGL, IAS, VS, PITCH and BANK. 

Three buttons appear with the graph: 

• FREEZE allows freezing a graph. It’s useful to handle (zoom/move) or print the graph (see 

below). Beware, none data are storage during a freeze 

• RESET resets ALL graphs at one stroke. 

• PRINT – To print the page 

 



16.2.1 Approach graphs 

You need to select an active runway before to use this feature. 

   

This screen has 3 parts: 

16.2.1.1 Information header part 

 
You find some runway (on the left) and aircraft (on the right information). 

For ILS, the glide value appears.

 

16.2.1.2 The vertical/horizontal approach graphs part 

Beware about the glide. For ILS approach, the glide value is known, and the graph uses it. In the other 

case, FS Instructor uses the standard glide (3° / 5.2 %) 

16.2.1.3 Range part 

 
Select the graphs range 

16.2.1.4 Report 

• How it works 

You can export an approach diagram to a pdf file or to a printer. 

When FS Instructor detects a touchdown, it creates a report. Then, an “Export Report” green button 

appears. 

 



It opens the last report pdf file. It is saved into the REPORTS directory located in FS Instructor. This 

directory is created when the first report pdf is generated 

 

 

 

To read this file please install a PDF reader software. 

• Report content 

You will find this data: 

o INFORMATION:  

▪ Airport ICAO Code + current runway 

▪ Horizontal visibility 

▪ Wind direction (°)/speed (kts) on ground 

▪ Ambient temperature on ground 

▪ Touchdown Datetime 

o TOUCHDOWN data: 

▪ RoD (Rate of Descent) 

▪ G Force 

▪ Bank angle 

▪ Pitch 

▪ IAS 

▪ Centerline deviation 

▪ Threshold distance 

o Aircraft data 

▪ Spoiler state 

▪ Total Weight 

▪ Landing distance 



 

• The header  

If you own a commercial license, you can customize the header 

image by changing the header.png image located in the FS 

Instructor/CUSTOM directory 

 

16.2.2 Real time parameters graphs 

 
 

Some events appear on the graph: 

Elements Error 

IAS Overspeed 
IAS > 250kts under 10 000’’ 

VS Vertical speed > MAX Vertical Speed setting (see menu > Preference) 



PITCH Pitch > 20° 
BANK Bank angle > MAX BANK ANGLE setting (see menu > Preference) 
AP Shows Autopilot ON/OFF (available for FSX standard plane) 
GEAR Show Gear movements 
FLAPS Shows flaps movements 
SPOILER Show Airbrake movements (Retracted / Armed / Deployed) 
STALL Show STALL Warnings 

 

 

16.2.3 Handle the graphs  

With your mouse, you can: 

- Scroll Wheel: you zoom/unzoom 

- Right click: a menu appears depending on your OS language 

 

 
You can copy the picture, save it on your hard drive, print it… 

- Left click: it selects a graphic range to zoom on it 

 



16.3 Google Earth – tracking 
FS Instructor permits to show in real time the airplane in Google Earth. 

Set Google Earth before (see 16.3.1 Google Earth settings) and activate this feature into the FS 

Instructor settings > Black Box. 

 
 

The application will automatically choose the best zoom depending your flight phase.  

You can choose to add some information to Google earth. 

Show local Approaches generates, in a 100nm range around the 

aircraft, approach road. 

o We use the standard glide (5.2% / 3°). It couldn’t match with 

the true operative rate of the runway. 

o The approach entry is located 12nm before runway threshold 

o Only > 4000’’ length concrete runways appear 

o During flight, you can generate this file again. 

Show local VOR / ILS / NDB generate NAVAID in a 100nm range 

around the aircraft.  

 

 



Top view

 

Lateral view 

 



 

In the Google Earth right lateral bar, you have access to all 

approaches (RUNWWAYS folder) 

- OACI code, Runway number, QFU 

- Runway length and ILS frequency  

 

By clicking one time on the runway link, information appears 

on the scope. 

By double clicking, scope view goes on this approach. 

 

 

 

 

 

 

 

 

 

16.3.1 Google Earth settings 

If you want to use the tracking, you must set up Google Earth. 

Places > Add > Network link 

  



 

 

1 – Choose a name 

2 - Link: Write the aircraft.kml file address which is in your «FS Instructor/OUPUT » directory. It is 

created when you launch tracking for the first time. 

3 – Open the Refresh Tab 

4 – Select Periodically and 4 seconds 

5 – Check “Direct access to the view during actualization” or “Fly to view on refresh” to center view 

on the aircraft. 

 Now, you see the network link in your lateral bar 

What to do if I see the plane but the camera moves slowly or not at all? 

Go to Google Earth options, Navigation tab. My favorite Fly-To-Speed is 0.1460. You can grow this 

2 

3 

4 

5 

1 



value to speed-up the camera move. 

 

When you try to open the aircraft information module inside Google Earth, the bar disappears  

Please set Google Earth into DirectX mode

 



16.3.2 Google Earth Tricks 

If you want to measure the angle and the distance between the aircraft and a location on the map, 

you can use the “ruler” (Google Earth > Tools > Ruler).

 

 

17 Remote COMPUTERS system 
Install and set “Soft Launcher V4 client” on each computer you want to control. See chapter 17.2 

Soft Launcher) 

If you own Soft Launcher V2 you please upgrade to V4: http://fsinstructor.com/news/?product=soft-

launcher-v4 

This software works as a client. It's dedicated to start automatically all needed software shared on 

several computers. For example, on your first computer, it starts Prepar3D. Waits 60 sec. After, it 

launches Flight Illusion gauges, wait 15sec and starts Project Magenta/PROSIM. When it’s done, it 

gives the focus to the Flight Simulator in a full screen mode. During this time, on your second 

machine, other softs are started automatically. While all these steps, pilots only see a message on 

the full screens with a timer. 

Then, you have a control on this software from FS Instructor computer module. 

17.1 FS instructor Settings 
Menu file > config > Computers TAB 

http://fsinstructor.com/news/?product=soft-launcher-v4
http://fsinstructor.com/news/?product=soft-launcher-v4


Insert the remote computers using “Soft Launcher”. If you just field a machine name, the system will 

find this name on the network (NETBIOS), you can use an IP address to force it. 

 

Any modification of this screen is applied immediately. You don’t need to restart FS Instructor. 

 

17.2 Soft Launcher V4 

 

Soft Launcher is included with the FS Instructor. You can buy this software separately. It can be 

installed all your machine  

Each installation needs a specific license. Please send us the given id to generate your licenses. 

It is dedicated to start and control automatically all your software’s needed for your simulator and 

shared on several computers.  



During start, pilots see only a message on the full screens with a timer and a logo (Ready in x 

seconds).  

 

On this image, 3 different computers 

are started. User doesn’t see the 

Windows desktop. All software is 

launching in the background. As soon 

as everything is ready, Soft Launcher 

gives the hand. 

You just have to set your computers 

to start when they are supply with 

electrical power. After, you have just 

to wait.  

Please contact us to know the tariff: 

- To personalize this waiting 

screen (logo + colors) 

- For a remote assistance to set your machine. 

Thanks to this software you can also manage these software’s. Imagine your Flight Illusion gauges 

don’t react. With FS Instructor you can ask, by remote, to kill and launch again this part only. 

17.2.1 Requirements 

• .NET Framework 4.5 

• Win 7 and + (32 or 64 bits) 

• None firewall on 5029 port (you can choose another setting port) 



17.2.2 How to set your software 

 

Directory: Click on “Directory” button to choose the file to execute 

After wait: choose the waiting time after the execution of the selected program 

Minimized: if you check it, Soft Launcher tries to minimized the window of the selected program 

(some software’s don’t support it) 

kill app: it the name that appears into the software window title 

 here Microsoft Flight. Beware of the case of the text. You 

can insert only the first string. Such as Microsoft 

some program doesn’t open a window and are only present into Windows Process. So, check Proc. It 

means that it will find the name into the Processes task manager. 

 

Beware some full screen mode can stick software’s. If you run Flight Simulator X or Prepar3D into a 

full screen mode, we advise to start them at the end. 



17.3 FS Instructor Remote Computer module 

 

17.3.1 On the left: remote machines list (see previous chapter). 

When you click on a machine, it tries to connect to the remote Soft Launcher. If it works, the rest of 

the screen appears. 

If it can’t be connected, “Unable to connect” appears after a while.

 



17.3.2 On the middle: remote applications 

If the connection is established, the remote applications are shown 

 

You can restart one of them. Just click on “RESTART” button to re-launch one application. 

The last line gives the focus on a program. Such as PROSIM Display or Prepar3D 

17.3.3 On the right: restart/shutdown machine(s) 

SHUTDOWN CABIN Button stops all machines. It tries to connect on each machine 

and ask to stop after one minute. You can go. After a while (2 min) all your 

computers are stopped 

RESTART CABIN button restarts all machines. Beware, it doesn’t stop electricity 

feed. So, I you have issues with interface like CP FLIGHT. It’s better to Shut down, 

stopped electrical power, wait 1 min and restart all. 

 

 

Control a machine: 

RESTART THE SCRIPT asks Soft Launcher to kill and restart all the application of 

one machine 

RESTART IT: restart only this machine after 1 minute. 

SHUTDOWN IT: Stop only this machine after 1 minute. 

 

 

Note: When you exit from FS Instructor, the system will ask 

automatically if you want to shut down the cabin. 

 



17.3.4 If something goes wrong 

If you can’t connect to soft launcher check: 

- Start Soft Launcher as administrator 

- Give rights in your Firewall 

- Try to stop your security suit 

- Check in <your user>/APPDATA/ROAMING/Soft Launcher/ the log file 

18 View & Slew PAGE 

  

This page is split into 2 modules. Slew mode on the left and View settings on the right 

18.1 Slew mode 
The slew mode allows the instructor to move the aircraft. To activate this mode, just click on the 

“Activate Slew Mode” button  



  

 

To exit from the slew mode, you have to click on “DEACTIVATE”

 

18.2 Views management 
The view module works ONLY into the Virtual Cockpit View with PREPAR3D. Some of these features 

don’t work with the 2D view. 

18.2.1 Zoom 

  
You can increase or decrease the current zoom (quick and slew buttons) 



18.2.2 View change 

 
The green arrows change the orientation of the view.  

“External Views” button switches the view (spot) to come back into the cabin, use the button 

“Return to cockpit View” 

CPT & F/O buttons switch between the CAPTAIN and FIRST OFFICER views to avoid parallax. 

To allow this function, ask us our handbook to set these views (only commercial licensed users). 

19 Printer module 
This module manages the USB thermal printer and simulates the Acars 

system. 

These printers are very close to the Airbus or Boeing pedestal printer.

 

 



 

On the left, you have the three areas of the message: 

• Header 

• Body 

• Footer 

You can use the %date% variable to display the current date 

On the right, it displays a printer preview.  

By clicking on PRINT, it sends the message on the DEFAULT printer connected on the local machine. 

None window appears. 

You can save the current message with the SAVE button. 

 



20 Motion Page 
This feature is only available for Revolution-Simproducts full motion.

 
 

21 Personalized the interface look 

21.1 Backgrounds 

FS Instructor is delivered with B737 background but you can custom this image with your specific 

aircraft (helo, Airbus, Cessna…). 

 

 
 



 

 

 

 

 

Only Integrator and Commercial licenses have access to this feature. 

1 – Open the custom directory 

 



2 – In this directory you will find the default shape 

 

Copy “Example for aircraft shape for backgrounds.jpg” and rename it to “aircraft shape for 

backgrounds.jpg”. Modify this file to display your own aircraft. 

Advice: 

- Choose a top-view with the aircraft nose on the left 

- Do not resize the image 

- Keep a black background. 

21.2 Display your logo instead of “FS Instructor splash screen” 
During start-up, a splash screen appears 

 



We have a dedicated service to integrate your own logo. Please contact us for pricing 

(contact@fsinstructor.com) 

 

21.3 Hide some pages 
You can customize the menu bar.  

Such as, from this menu bar: 

To

 

MENU > SETTINGS > MENU.  

 

You find a list of the pages.  

- check or uncheck which page you want (Show column) 

mailto:contact@fsinstructor.com


- Change the order (UP/DN buttons). 

- Change the display name (NAME column) 

22 FS Instructor Add-ons 
FS Instructor is an open software. Editor car write plugins. 

They appear as page. 

Currently DODOSIM PROFESSIONAL is available 

23 IPhone/IPad and Android support 
You can open a remote session from your IPhone or Android to your FS Instructor PC instance by 

installing Air Display http://avatron.com/apps/air-display

 

24 FAQ 

24.1 Is FS Instructor control planes on IVAO/VATSIM servers? 
No, FS Instructor and VATSIM/IVAO don’t use the same protocol. 

 

24.2 Does it manage many planes? 

Commercial users can launch several FS Instructor from the same computer and manage several 

WideClient connections.  

One FS instructor is linked to one WideClient. 

Please contact us to have the complete procedure. 

http://avatron.com/apps/air-display
http://avatron.com/apps/air-display


24.3 Can people switch to FSX or Prepar3D without restarting the application? 
No, each time you restart the flight simulator you should reopen FS instructor. If not, some features 

loaded at the beginning of the application could not work (Find a gate for example).  

25 Additional service for professional/integrators 

• Remote installation, configuration, customization of our products... 
• New developments 
• For simulator renters, a FS instructor plugin to manage cabin access from RFID badge. 

 

 

 

 

 

 

 

 

• To help you to certificate your 

sim: Qualification Test Studio. 

 
This tool has been developed to assist with the Master and Recurrent Qualification Test 

preparation (MQTG/RQTG) for sim based on FSUIPC (FSX and higher) or XPLANE 

What you can do: 

o Create your own scenarios/tests found in MQTG/RQTG guides. 

o Record these tests 

o Obtain pdf or jpg files with all recorded events. You can customize the header. 

• We provide over fifty different events to record but you can personalize the tool creating 

your specific FSUIPC offsets.  

• If you are interesting by Qualification Test Studio, tell us and we will send you a demo. 

  



26 Manage several sims at a same time 
You can start several FS Instructor’s (one instance= one license) under a same Windows session. Each 

one can manage one simulator 

 

Please ask us the documentation to set this architecture. 

27  Copyrights 
FS Instructor uses these components: 

• FSUIPCClient.dll - version 2.4 by Paul Henty 

• ZedGraph - version 5.1.5 

• FSUIPC and WideFS by Peter Dowson (Payware) - http://www.schiratti.com/dowson.html 

• PdfSharp – version 1.32 
 

FS Instructor could be interfaced with 

• PROSIM - http://prosim737.com (Payware) 

• DODOSIM http://www.dodosim.com/ (payware) 

• Air Display http://avatron.com/apps/air-display (Payware) - © 2017 Avatron Software 
 

 
This software is not associated with any aircraft manufacturers. It can NOT be used for the real flight. It is 
designed exclusively for training simulator sessions. 
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